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Introduction 

Since the beginning of interest in risk modeling for cardiac surgery, the San Francisco 
Heart & Vascular Institute has maintained a large and detailed database of all of it's 
cardiac surgical procedures. Data from this database is submitted annually to the 
Society of Thoracic Surgeons National Cardiac Surgery Database.  Through the Duke 
Clinical Research Center, data from many institutions are collected together, analyzed, 
and used to produce risk models for various outcome categories and surgical 
populations.  The Society of Thoracic Surgeons’ risk models predict the risk of operative 
mortality and morbidity after adult cardiac surgery on the basis of patient demographic 
and clinical variables. The models are primarily used to adjust for case mix when 
comparing outcomes across institutions with different patient populations. Such 
comparisons are provided in the Database reports received by STS Database 
participants. The STS models are also used by physicians and patients as tools for 
understanding the possible risks of surgery. These risks are solely statistical 
estimates. They should be supplemented by the professional judgment of the 
patients’ healthcare provider, particularly their cardiologist and cardiac surgeon.  
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How To Use the Program 

Log On 

You must log on to use this program.  The log on window appears when you first 
attempt to run the program.  You must supply a username and password which will 
provided by your Administrator. 

 

Fill in your username and password, then press Enter.  You will be allowed 3 tries 
before the Log On closes with a message that your attempt to log on has failed and that 
you should contact your Administrator. 

Note that this log on feature prevents unauthorized users from gaining access to 
sensitive patient information. 

Further note that only a single instance of the main application can be run at any one 
time.  This feature is particularly important when the application is run from a server on 
a local access network, since it prevents users from simultaneously altering the patient 
database.  Should you successfully log into the application in the network that is already 
being run, you will receive a message that the application is currently unavailable and 
that you should try again later. 

The Main Interface 

The main program is an intuitive simple tabbed interface with a menu and tool bar, 
much like any standard Windows program. 
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There are 9 outcome models that are calculated for a given patient.  These are: Death, 
Stroke, Resp, Wound, Reop, Stay+ and Stay-.  These are indicated by labels at the 
bottom of the bar graph.  They are shown below and defined in Table 1.  The colored 
bars show the relative risk percentages for the 9 models.  The scale on the left of the 
graph indicates the risk percentage.  Additionally, respective values for each bar are 
show above the graph. 

 

Table 1. 
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Outcome Model Short Name Definition 
Operative Mortality Death Death within the current hospitalization 
Permanent Stroke Stroke Cerebrovascular accident with permanent residuae 

Renal Failure Renal Renal failure postoperatively (not relevant for 
patients preoperatively on dialysis) 

Prolonged 
Ventilatory Support 
> 24 Hrs 

Resp Postoperative ventilatory support > 24 hours or 
requiring reintubation 

Deep Sternal 
Wound Infection Wound Sternal wound infection and / or dehiscence 

Reoperation for 
Any Reason Reop Reoperation for bleeding or any other reason 

Any of the Above Any One or more of any of the above problems 
Prolonged Hospital 
Stay > 14 Days Stay + Hospitalization exceeding 14 days postop 

Short Hospital Stay 
< 6 Days Stay - Hospitalization less than 6 days postop 

The risk model outcome values can be read directly from the bar graph.  For ease of 
reading, outcome probabilities can be read more precisely from the value indicators 
immediately above the the bar graph.  Indicators are color coded to correspond to 
distinct bar graph colors that are unique to each model.  Should you choose to view 
them in order to compare your patient with the national averages as supplied by the 
Society of Thoracic Surgeons, a row of benchmarks can be displayed immediately 
above the outcome probability row of indicators.  These represent the average 
occurrence of a particular outcome for that entire risk category and procedure.  The 
benchmark indicators can be turned on and off by selecting the Benchmarks item under 
the Tools menu, or by clicking on the Benchmarks button on the toolbar, or by selecting 
the menu associated with the Benchmarks button down-arrow on the toolbar.  The 
benchmark indicators will always appear above the current patient outcome probability 
values.  All of these are expressed in percent, that is, the actual probability multiplied by 
100.0. 

 

The 7 tabs at the bottom of the interface allow you to select the appropriate surgical 
procedure category for a patient.  These are CABG, AVRepl, MVRepl, MVRepr, 
AVRepl+CABG, MVRepl+CABG, and MVRepr+CABG.  These are shown below and 
their meanings defined in Table 2. 
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Table 2. 

Surgical Procedure 
Category Tab Name Definition 

Isolated Coronary Artery 
Bypass  CABG Isolated coronary artery bypass only 

Isolated Aortic Valve 
Replacement  AVRepl Isolated aortic valve replacement only 

Isolated Mitral Valve 
Replacement  MVRepl Isolated mitral valve replacement only 

Isolated Mitral Valve 
Repair  MVRepr Isolated mitral valve repair only 

Aortic Valve Replacement 
+ CABG AVRepl+CABG Combined aortic valve replacement and 

coronary artery bypass 
Mitral Valve Replacement 
+ CABG MVRepl+CABG Combined mitral valve replacement and 

coronary artery bypass 
Mitral Valve Repair + 
CABG  MVRepr+CABG Combined mitral valve repair and coronary 

artery bypass 

In all, there are 7 procedure categories times 9 outcome models each category,  for a 
total of 63 available risk models.  All the risk models use the same patient preoperative 
variables. 

The Toolbar 

 

The toolbar facilitates the rapid execution of most of the menu selection items.   It 
contains ten buttons with mouse-over popup labels.  The first 4 buttons are typical 
Window's program interface buttons to facilitate clearing out the current data (New), 
Opening a patient file that is stored on disk (Open),  saving the currently loaded patient 
data to disk (Save), and printing the current patient data as text (Print).  The right-most 
button summons the program information box.  The function of the remaining six custom 
button operations are summarized in Table 3. 

Table 3. 

Button Label Function 



 

 8

 New Clears the current patient data from the risk calculator, 
zeros all the risk values 

 Open Opens a patient data file (smx) from the hard disk 

 Save Saves the existing patient data to a hard disk (smx) file 

 Print Prints the existing patient data and risk profile 

 Benchmarks Turns benchmark indicators on/off with button or arrow and 
menu 

 Edit Patient Opens the patient data editor filled with current patient 
entries 

 Quick View Opens the quick data view containing non-editable current 
patient data for viewing and printing 

 Add Patient Opens a blank patient data editor for entering new patient 
data 

 Data Manager Opens the database manager for selection and 
management of patient data 

 Save to Database Save the current data to the patient database 

 PCI Risk Calculate mortality risk for PCI 

 About Displays information about the program 

  

Adding a New Patient 

To add a new patient, you must complete the entry fields presented in the Add Patient 
window.  There are 40 fields in all, 37 of which are required to complete the calculation 
of a risk category.  The 3 fields, MRNum, Name, and Entry Date are only required if you 
wish to enter the new patient in the database.  You have the option of saving the patient 
data to the database, to disk, or to both.  If you try to calculate a risk model with one of 
the required 37 fields is missing, you will receive a message 'Parameter is incorrect', in 
which case, you should try to fill in the missing data point and try again. 
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Editing  Existing Patient Data 

You can change or edit currently loaded patient data.  Click the Edit Patient button on 
the toolbar or make the selection from the Tools menu.  The Patient Edit window will 
appear containing all of the current patient input variables.  You can change these 
variables and, by clicking on the Update button, you can view the effect that the change 
has on the calculated risk models. 
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 11

 

The Quick Viewer 

This window allows you to quickly review data of the current patient.  You cannot edit 
the data from this window. (For editing data, use the Patient Editor).  However, you can 
print the Quick Viewer data to a text file.  Note that the print function will print both the 
current patient data and the results of the 9 risk models for the selected procedure 
category.   
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The Data Manager 

It may be more convenient for some users to store patients in a database rather than to 
a hard disk as a file.  To facilitate this, the program provides a database interface, the 
Data Manager.  The Data Manager window  allows for loading, adding, deleting, 
searching and ordering of an MS Access database.   
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Patients are listed by their identification number  (Pt ID), Name, Entry Date, and Age.  
The list can be sorted by Pt ID, Name, or Entry Date by clicking on the desired ordering 
mode check button.  The list can be searched for a specific patient by either Pt ID or 
Name through the use of the two buttons provided.  Four buttons control loading patient 
data, adding a new patient to the database, deleting a patient from the database, and 
seeking online help (see Table 4).  Any patient listed in the database can be loaded 
onto the Risk Calculator by either double-clicking on the list name, or by selecting them 
from the list and clicking on OK or the Load Selected Patient button. 

Table 4. 

Button Label Function 

 
Load Selected Patient Loads the selected patient data into the main risk 

modeler program 

 Add New Patient Opens the patient data entry interface to add a new 
patient to the database 
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Delete Selected Patient Deletes the selected patient data from the database 

 
Data Manager Help Opens Database Manager help (this file) 

  

The Main Menu 

The Main Menu is a typical Windows menu that consists of four main selections, File, 
View, Tools, and Help.  These are largely intuitive and self-explanatory.   

The File menu subitems allow input and output of patient data files.  In this application, 
these files are of the type SMX.  These SMX files are binary files that can only be 
opened using this application. 

 

The View menu subitems allow for selection of specific procedure categories.  The 
current selection is checked on the menu and the corresponding tab is highlighted. 

 

 

The Tools menu subitems correspond to the Toolbar buttons 
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The Help menu subitems offer choices for online help contents and information about 
the program. 

 

The Toolbar Menu 

The Benchmark toolbar button is associated with a down-arrow button which, when 
clicked, displays a popup menu that allows you to quickly show or hide the benchmark 
indicators. 
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Printing a Report 

Load patient data, select the desired procedure category, and from the File menu select 
Print.  A typical patient printout will appear as that example below. 
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Definitions 

 
A  
Arrhythmia Type-Afib/Aflutter  
C  
CAB  
Cardiac Presentation on Admission  
Classification-NYHA  
H  
Heart Failure  
Height (cm)  
Hemo Data-EF  
Hispanic or Latino Ethnicity  
I  
IABP-When Inserted  
Incidence  
L  
Left Main Dis >= 50%  
M  
Meds-Inotropes  
MI-When  
N  
Num Dis Vessels  
O  
Other Card  
Other Card-Ao Aneur  
Other Card-Arrhythmia Correction Surgery  
Other Card-ASD  
Other Card-Atrial Fibrillation Correction Surgery  
Other Card-Batista  
Other Card-Card Tx  
Other Card-Cardiac Trauma  
Other Card-Congenital  
Other Card-LVA  
Other Card-Other  
Other Card-Surgical Ventricular Restoration  
Other Card-Transmyocardial Laser Revascularization  
Other Card-VSD  
Other Non Card  
P  
Patient Age  
Prev CAB  
Prev Oth Card-PCI-Interval  
Prev Valve  
R  
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Race - Black / African American  
Race - Asian  
Resuscitation  
RF - Peripheral Arterial Disease  
RF-Cerebrovascular Dis  
RF-Chronic Lung Dis  
RF-CVA  
RF-Diabetes  
RF-Diabetes-Control  
RF-Hypertension  
RF-Immunosuppressive Rx  
RF-Infect Endocard Type  
RF-Last Creat Lvl  
RF-Renal Fail-Dialysis  
S  
Sex  
Status  
STS Cardiogenic Shock  
V  
VAD  
Valve  
VD-Insuff-Aortic  
VD-Insuff-Mitral  
VD-Insuff-Tricuspid  
VD-Stenosis-Aortic  
VD-Stenosis-Mitral  
VS-Aortic Proc-Procedure  
VS-Mitral Proc-Procedure  
VS-Pulmonic Proc-Procedure  
VS-Tricuspid Proc-Procedure  
W  
Weight (kg)  
 
 
Arrhythmia Type-Afib/Aflutter  
Indicate whether atrial fibrillation or flutter is present within two weeks of the procedure.  
 
 
CAB  
Indicate whether coronary artery bypass grafting was done.  
 
 
Cardiac Presentation on Admission  
Indicate the type of angina present prior to this surgical intervention.  
1- No Symptoms or Angina.  
2- Symptoms Unlikely to be Ischemia: Pain, pressure or discomfort in the chest, neck or 
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arms not clearly exertional or not otherwise consistent with pain or discomfort of 
myocardial ischemic origin. This includes patients with non-cardiac pain (e.g. pulmonary 
embolism, musculoskeletal, or esophageal discomfort), or cardiac pain not caused by 
myocardial ischemia (e.g., acute pericarditis).  
3- Stable Angina: Angina without a change in frequency or pattern for the six weeks 
prior to this surgical intervention. Angina is controlled by rest and/or oral or 
transcutaneous medications.  
4- Unstable Angina - There are three principal presentations of unstable angina: 1) rest 
angina, 2) new -onset (less than 2 months) angina, and 3) increasing angina (in 
intensity, duration and/or frequency).  
5- Non-ST Elevation MI (Non-STEMI) - The patient was hospitalized for a non-ST 
elevation myocardial infarction as documented in the medical record. Non-STEMIs are 
characterized by the presence of both criteria: A. Cardiac biomarkers (creatinine kinase-
myocardial band, Troponin T or I, and/or myoglobin) exceed the upper limit of normal 
according to the individual hospital's laboratory parameters with a clinical presentation 
which is consistent or suggestive of ischemia. ECG changes and/or ischemic symptoms 
may or may not be present. B. Absence of ECG changes diagnostic of a STEMI (see 
STEMI).  
6- ST Elevation MI (STEMI) - The patient presented with a ST elevation myocardial 
infarction as documented in the medical record. STEMIs are characterized by the 
presence of both criteria: A. ECG evidence of STEMI: New or presumed new ST-
segment elevation or new left bundle branch block not documented to be resolved 
within 20 minutes. ST-segment elevation is defined by new or presumed new sustained 
ST-segment elevation (0.1 mV in magnitude) in two or more contiguous 
electrocardiogram (ECG) leads. If no exact ST-elevation measurement is recorded in 
the medical chart, physician?s written documentation of ST-elevation is acceptable. If 
only one ECG is performed, then the assumption that the ST elevation persisted at least 
the required 20 minutes is acceptable. Left bundle branch block (LBBB) refers to LBBB 
that was not known to be old on the initial ECG. For purposes of the Registry, ST 
elevation in the posterior chest leads (V7 through V9), or ST depression in V1 and V2 
demonstrating posterior myocardial infarction is considered a STEMI equivalent and 
qualifies the patient for reperfusion therapy. B. Cardiac biomarkers (creatinine kinase-
myocardial band, Troponin T or I, and/or myoglobin) exceed the upper limit of normal 
according to the individual hospital's laboratory parameters a clinical presentation which 
is consistent or suggestive of ischemia which is consistent or suggestive of ischemia.  
 
 
Classification-NYHA  
Indicate the patient's highest New York Heart Association (NYHA) classification within 2 
weeks prior to surgery. NYHA classification represents the overall functional status of 
the patient in relationship to both heart failure and angina. Choose one of the following: 
- Class I: Patient has cardiac disease but without resulting limitations of ordinary 
physical activity. Ordinary physical activity (e.g., walking several blocks or climbing 
stairs) does not cause undue fatigue, palpitation, dyspnea, or anginal pain. Limiting 
symptoms may occur with marked exertion. - Class II: Patient has cardiac disease 
resulting in slight limitation of ordinary physical activity. Patient is comfortable at rest. 
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Ordinary physical activity such as walking more than two blocks or climbing more than 
one flight of stairs results in limiting symptoms (e.g., fatigue, palpitation, dyspnea, or 
anginal pain). - Class III: Patient has cardiac disease resulting in marked limitation of 
physical activity. Patient is comfortable at rest. Less than ordinary physical activity (e.g., 
walking one to two level blocks or climbing one flight of stairs) causes fatigue, 
palpitation, dyspnea, or anginal pain. - Class IV: Patient has dyspnea at rest that 
increases with any physical activity. Patient has cardiac disease resulting in inability to 
perform any physical activity without discomfort. Symptoms may be present even at 
rest. If any physical activity is undertaken, discomfort is increased.  
 
 
Heart Failure  
Indicate whether, within 2 weeks prior to the initial surgical procedure, a physician has 
diagnosed that the patient is currently in heart failure (HF). HF can be diagnosed based 
on careful history and physical exam, or by one of the following criteria: 1. Paroxysmal 
nocturnal dyspnea (PND); 2. Dyspnea on exertion (DOE) due to heart failure; 3. Chest 
X-ray (CXR) showing pulmonary congestion; 4. Pedal edema or dyspnea, and receiving 
diuretics; or 5. Pulmonary edema. Note: A low ejection fraction without clinical 
presentation does not qualify for history of heart failure.  
 
 
Height (cm)  
Indicate the height of the patient in centimeters.  
 
 
Hemo Data-EF  
Indicate the percentage of the blood emptied from the ventricle at the end of the 
contraction. Use the most recent determination prior to the surgical intervention 
documented on a diagnostic report. Enter a percentage in the range of 1 - 99. If a 
percentage range is reported, report a whole number using the "mean" (i.e., 50-55%, is 
reported as 53%). Values reported as: Normal = 60% Good function = 50% Mildly 
reduced = 45% Fair function = 40% Moderately reduced = 30% Poor function = 25% 
Severely reduced = 20% NOTE: If no diagnostic report is in the medical record, a value 
documented in the progress record is acceptable.  
 
 
Hispanic or Latino Ethnicity  
Indicate if the patient is of Hispanic or Latino ethnicity as determined by the patient / 
family. Hispanic or Latino ethnicity includes patient report of Cuban, Mexican, Puerto 
Rican, South or Central American, or other Spanish culture or origin, regardless of race.  
 
 
IABP-When Inserted  
Indicate when the IABP was inserted. Choose one of the following: Preoperatively 
Intraoperatively Postoperatively  
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Incidence  
Indicate if this is the patient's: -first cardiovascular surgery -first re-op cardiovascular 
surgery -second re-op cardiovascular surgery -third re-op cardiovascular surgery -fourth 
or more re-op cardiovascular surgery.  
 
 
Left Main Dis >= 50%  
Indicate whether the patient has Left Main Coronary Disease. Left Main Coronary 
Disease is present when there is >= 50% compromise of vessel diameter 
preoperatively.  
 
 
Meds-Inotropes  
Indicate whether the patient received IV inotropic agents within 48 hours preceding 
surgery, or if it was contraindicated or not indicated. The contraindication must be 
documented in the medical record by a physician, nurse practitioner, or physician 
assistant.  
 
 
MI-When  
Indicate the time period between the last documented myocardial infarction and 
surgery.  
 
 
Num Dis Vessels  
Indicate the number of diseased major native coronary vessel systems: LAD system, 
Circumflex system, and/or Right system with >= 50% narrowing of any vessel 
preoperatively. NOTE: Left main disease (>=50%) is counted as TWO vessels (LAD 
and Circumflex, which may include a Ramus Intermedius). For example, left main and 
RCA would count as three total. Select from the following: None (no significant coronary 
obstructive disease) One Two Three  
 
 
Other Card  
Indicate whether an other cardiac procedure was done (other than CABG and/or Valve 
procedures).  
 
 
Other Card-Ao Aneur  
Indicate whether the patient underwent an aortic aneurysm repair either in conjunction 
with, or as the primary surgical procedure. This includes dissections, non-dissections 
and ruptures of the aorta.  
 
 
Other Card-Arrhythmia Correction Surgery  
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Indicate if one of the following arrhythmia correction devices was surgically placed 
either in conjunction with, or as the primary surgical procedure: None Permanent 
Pacemaker: an internal electronic generator that controls the heart rate. Permanent 
Pacemaker with Cardiac Resynchronization Therapy (CRT): an internal permanent 
pacemaker that uses biventricular electrical stimulation to synchronize ventricular 
contraction. Automatic Implanted Cardioverter Defibrillator (AICD): an internal device 
that defibrillates the heart. AICD with CRT: an internal AICD that uses biventricular 
electrical stimulation to synchronize ventricular contraction.  
 
 
Other Card-ASD  
Indicate whether the patient had an Atrial Septal Defect Repair either in conjunction 
with, or as the primary surgical procedure including but not limited to ASD, Secundum; 
ASD, Sinus venosus; and PFO.  
 
 
Other Card-Atrial Fibrillation Correction Surgery  
Indicate if one of the following atrial fibrillation correction surgeries was performed either 
in conjunction with, or as the primary surgical procedure. The intent of both surgeries is 
to preclude the atria from fibrillating by disrupting the abnormal reentry pathways of 
electronic signals that lead to atrial fibrillation. Standard Surgical Maze Procedure: 
Surgical procedure in which full thickness incisions are made in the atria of the heart. 
Sutures are then used to reapproximate the incised tissue. The resulting lesion disrupts 
the abnormal reentry pathways of electronic signals that lead to atrial fibrillation. Other 
Surgical Ablative Procedure: Surgical procedure in which lesions are created in the atria 
of the heart by an energy source. The lesion disrupts the abnormal reentry pathways of 
electronic signals that lead to atrial fibrillation. Combination of Standard Surgical Maze 
Procedure and Other Surgical Ablative Procedure.  
 
 
Other Card-Batista  
Indicate whether the patient had a Left Ventricular Reduction Myoplasty either in 
conjunction with, or as the primary surgical procedure. Left Ventricular Reduction 
Myoplasty is a procedure whereby left ventricular myocardium is excised to reduce left 
ventricular volume in patients with a dilated cardiomyopathy, with or without mitral valve 
replacement or repair. If a concomitant valve procedure is performed, please check that 
category also.  
 
 
Other Card-Card Tx  
Indicate whether the patient had a Heterotopic or Orthotopic heart transplantation either 
in conjunction with, or as the primary surgical procedure.  
 
 
Other Card-Cardiac Trauma  
Indicate whether the patient had a surgical procedure for an injury due to Cardiac 
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Trauma either in conjunction with, or as the primary surgical procedure.  
 
 
Other Card-Congenital  
Indicate whether the patient had a congenital defect repair either in conjunction with, or 
as the primary surgical procedure.  
 
 
Other Card-LVA  
Indicate whether the patient had a Left Ventricular Aneurysm Repair either in 
conjunction with, or as the primary surgical procedure.  
 
 
Other Card-Other  
Indicate whether the patient had an other cardiac procedure performed either in 
conjunction with, or as the primary surgical procedure that is not included within this 
section. Includes, but is not limited to those procedures listed on the STS Data 
Manager's section of the STS Web Site.  
 
 
Other Card-Surgical Ventricular Restoration  
Indicate whether the patient had a Surgical Ventricular Restoration either in conjunction 
with, or as the primary surgical procedure. Surgical Ventricular Restoration are 
procedures that restore the geometry of the heart after an anterior MI. They include the 
Dor procedure or the SAVER procedure. This SVR procedure is distinct from an anterior 
left ventricular aneurysmectomy (LVA) and from a Batista procedure (left ventricular 
volume reduction procedure).  
 
 
Other Card-Transmyocardial Laser Revascularization  
Indicate whether the patient underwent the creation of multiple channels in left 
ventricular myocardium with a laser fiber either in conjunction with, or as the primary 
surgical procedure.  
 
 
Other Card-VSD  
Indicate whether the patient had a Ventricular Septal Defect Repair either in conjunction 
with, or as the primary surgical procedure.  
 
 
Other Non Card  
Indicate whether a non-cardiac procedure was done.  
 
 
Patient Age  
Indicate the patient's age in years, at time of surgery. This should be calculated from the 
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date of birth and the date of surgery, according to the convention used in the USA (the 
number of birthdate anniversaries reached by the date of surgery). If age is less than 
18, the data record will be accepted into the database, but will not be included in the 
national analysis and report.  
 
 
Prev CAB  
Indicate whether the patient had a previous Coronary Bypass Graft prior to the current 
admission.  
 
 
Prev Oth Card-PCI-Interval  
Indicate the interval of time between the previous PCI and the current surgical 
procedure.  
 
 
Prev Valve  
Indicate whether the patient had a previous surgical replacement and/or surgical repair 
of a cardiac valve. This may also include percutaneous valve procedures.  
 
 
Race - Black / African American  
Indicate whether the patient's race, as determined by the patient or family, includes 
Black / African American. This includes a person having origins in any of the black racial 
groups of Africa. Terms such as "Haitian" or "Negro" can be used in addition to "Black 
or African American." Definition source: Standards for Maintaining, Collecting, and 
Presenting Federal Data on Race and Ethnicity : The minimum categories for data on 
race and ethnicity for Federal statistics, program administrative reporting, and civil rights 
compliance reporting. (www.whitehouse.gov/omb/fedreg/1997standards.html)  
 
 
Race - Asian  
Indicate whether the patient's race, as determined by the patient or family, includes 
Asian. This includes a person having origins in any of the original peoples of the Far 
East, Southeast Asia, or the Indian subcontinent including, for example, Cambodia, 
China, India, Japan, Korea, Malaysia, Pakistan, the Philippine Islands, Thailand, and 
Vietnam. Definition source: Standards for Maintaining, Collecting, and Presenting 
Federal Data on Race and Ethnicity : The minimum categories for data on race and 
ethnicity for Federal statistics, program administrative reporting, and civil rights 
compliance reporting. (www.whitehouse.gov/omb/fedreg/1997standards.html)  
 
 
Resuscitation  
Indicate whether the patient required cardiopulmonary resuscitation within one hour 
before the start of the operative procedure.  
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RF - Peripheral Arterial Disease  
Indicate whether the patient has a history of peripheral arterial disease (includes upper 
and lower extremity, renal, mesenteric, and abdominal aortic systems). This can 
include: 1. Claudication , either with exertion or at rest, 2. Amputation for arterial 
vascular insufficiency, 3. Vascular reconstruction, bypass surgery, or percutaneous 
intervention to the extremities (excluding dialysis fistulas and vein stripping), 4. 
Documented aortic aneurysm with or without repair, 5. Positive noninvasive test (e.g., 
ankle brachial index =< 0.9, ultrasound, magnetic resonance or computed tomography 
imaging of > 50% diameter stenosis in any peripheral artery, i.e., renal, subclavian, 
femoral, iliac). Peripheral arterial disease excludes disease in the carotid or 
cerebrovascular arteries.  
 
 
RF-Cerebrovascular Dis  
Indicate whether the patient has Cerebro-Vascular Disease, documented by any one of 
the following: CVA (symptoms > 24 hrs after onset, presumed to be from vascular 
etiology); TIA (recovery within 24 hrs); Non-invasive carotid test with > 79% diameter 
occlusion.; or Prior carotid surgery. Does not include neurological disease processes 
such as metabolic and/or anoxic ischemic encephalopathy.  
 
 
RF-Chronic Lung Dis  
Indicate whether the patient has chronic lung disease, and the severity level according 
to the following classification: No; Mild: FEV1 60% to 75% of predicted, and/or on 
chronic inhaled or oral bronchodilator therapy. Moderate: FEV1 50% to 59% of 
predicted, and/or on chronic steroid therapy aimed at lung disease. Severe: FEV1 <50% 
predicted, and/or Room Air pO2 < 60 or Room Air pCO2 > 50.  
 
 
RF-CVA  
Indicate whether the patient has a history of stroke (i.e., any confirmed neurological 
deficit of abrupt onset caused by a disturbance in cerebral blood supply) that did not 
resolve within 24 hours.  
 
 
RF-Diabetes  
Indicate whether the patient has a history of diabetes, regardless of duration of disease 
or need for anti-diabetic agents. Includes on admission or preoperative diagnosis. Does 
not include gestational diabetes.  
 
 
RF-Diabetes-Control  
Indicate the method of diabetic control. Code the control method patient presented with 
on admission. Patients placed on a pre-operative diabetic pathway of Insulin drip but at 
admission were controlled with NONE, diet or oral method are not coded as insulin 
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dependent. Choices are: None = No treatment for diabetes. Diet = Diet treatment only. 
Oral = Oral agent treatment (includes oral agent with/without diet treatment). Insulin = 
Insulin treatment (includes any combination with insulin). Other = Other adjunctive 
therapy  
 
 
RF-Hypertension  
Indicate whether the patient has a diagnosis of hypertension, documented by one of the 
following: a. Documented history of hypertension diagnosed and treated with 
medication, diet and/or exercise b. Prior documentation of blood pressure >140 mmHg 
systolic or 90 mmHg diastolic for patients without diabetes or chronic kidney disease, or 
prior documentation of blood pressure >130 mmHg systolic or 80 mmHg diastolic on at 
least 2 occasions for patients with diabetes or chronic kidney disease c. Currently on 
pharmacologic therapy to control hypertension  
 
 
RF-Immunosuppressive Rx  
Indicate whether the patient has used any form of immunosuppressive therapy within 30 
days preceding the operative procedure. This includes, but is not limited to inhaled or 
systemic steroid therapy and chemotherapy. This does not include topical applications, 
one time systemic therapy, or preoperative protocol.  
 
 
RF-Infect Endocard Type  
Indicate the type of endocarditis the patient has. If the patient is currently being treated 
for endocarditis, the disease is considered active. If no antibiotic medication (other than 
prophylactic medication) is being given at the time of surgery, then the infection is 
considered treated.  
 
 
RF-Last Creat Lvl  
Indicate the creatinine level closest to the date and time prior surgery. A creatinine level 
should be collected on all patients, even if they have no prior history. A creatinine value 
is a high predictor of a patient's outcome and is used in the predicted risk models.  
 
 
RF-Renal Fail-Dialysis  
Indicate whether the patient is currently undergoing dialysis.  
 
 
Sex  
Indicate the patient's sex at birth as either male or female.  
 
 
Status  
Indicate the clinical status of the patient prior to entering the operating room: Elective: 



 

 27

The patient's cardiac function has been stable in the days or weeks prior to the 
operation. The procedure could be deferred without increased risk of compromised 
cardiac outcome. Urgent: Procedure required during same hospitalization in order to 
minimize chance of further clinical deterioration. Examples include but are not limited to: 
Worsening, sudden chest pain, CHF, acute myocardial infarction (AMI), anatomy, IABP, 
unstable angina (USA) with intravenous (IV) nitroglycerin (NTG) or rest angina. 
Emergent: Patients requiring emergency operations will have ongoing, refractory 
(difficult, complicated, and/or unmanageable) unrelenting cardiac compromise, with or 
without hemodynamic instability, and not responsive to any form of therapy except 
cardiac surgery. An emergency operation is one in which there should be no delay in 
providing operative intervention. The patient?s clinical status includes any of the 
following: a. Ischemic dysfunction (any of the following): (1) Ongoing ischemia including 
rest angina despite maximal medical therapy (medical and/or IABP)); (2) Acute Evolving 
Myocardial Infarction within 24 hours before surgery; or (3) pulmonary edema requiring 
intubation. b. Mechanical dysfunction (either of the following): (1) shock with circulatory 
support; or (2) shock without circulatory support. Emergent Salvage: The patient is 
undergoing CPR en route to the OR or prior to anesthesia induction.  
 
 
STS Cardiogenic Shock  
Indicate whether the patient was, at the time of procedure, in a clinical state of 
hypoperfusion sustained for greater than 30 minutes, according to either of the following 
criteria: 1. Systolic BP < 80 and/or Cardiac Index < 1.8 despite maximal treatment; 2. IV 
inotropes and/or IABP necessary to maintain Systolic BP > 80 and/or CI > 1.8.  
 
 
VAD  
Indicate whether a ventricular assist device (VAD) was implanted.  
 
 
Valve  
Indicate whether a surgical procedure was done on the Aortic, Mitral, Tricuspid or 
Pulmonic valves.  
 
 
VD-Insuff-Aortic  
Indicate whether there is evidence of Aortic valve regurgitation. Enter level of valve 
function associated with highest risk (i.e., worst performance). Enter the highest level 
recorded in the chart. "Moderately severe" should be coded as "Severe". If data not 
available or study suboptimal, enter N/A.  
 
 
VD-Insuff-Mitral  
Indicate whether there is evidence of Mitral valve regurgitation. Enter level of valve 
function associated with highest risk (i.e., worst performance). Enter the highest level 
recorded in the chart. "Moderately severe" should be coded as "Severe". If data not 
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available or study suboptimal, enter N/A.  
 
 
VD-Insuff-Tricuspid  
Indicate whether there is evidence of Tricuspid valve regurgitation. Enter level of valve 
function associated with highest risk (i.e., worst performance). Enter the highest level 
recorded in the chart. "Moderately severe" should be coded as "Severe". If data not 
available or study suboptimal, enter N/A.  
 
 
VD-Stenosis-Aortic  
Indicate whether Aortic Stenosis is present. If not documented or not done, indicate as 
N/A.  
 
 
VD-Stenosis-Mitral  
Indicate whether Mitral Stenosis is present. If not documented or not done, indicate as 
N/A.  
 
 
VS-Aortic Proc-Procedure  
Indicate whether a surgical procedure was done or not done on the Aortic Valve. Select 
one of the following: a. No b. Replacement c. Repair/Reconstruction d. Root 
Reconstruction with Valve Conduit e. Replacement + Aortic Graft Conduit (not a valve 
conduit) f. Root Reconstruction w/ Valve Sparing g. Resuspension Aortic Valve with 
Replacement of Ascending aorta h. Resuspension Aortic Valve without Replacement of 
Ascending aorta i. Resection Sub-Aortic Stenosis  
 
 
VS-Mitral Proc-Procedure  
Indicate whether a surgical procedure was done or not done on the Mitral Valve. Select 
one of the following: a. No b. Annuloplasty only c. Replacement d. Reconstruction with 
Annuloplasty e. Reconstruction without Annuloplasty  
 
 
VS-Pulmonic Proc-Procedure  
Indicate whether a surgical procedure was done or not done on the Pulmonic Valve. 
Select one of the following: a. No b. Replacement c. Reconstruction  
 
 
VS-Tricuspid Proc-Procedure  
Indicate whether a surgical procedure was done or not done on the Tricuspid Valve. 
Select one of the following: a. No b. Annuloplasty Only c. Replacement d. 
Reconstruction with Annuloplasty e. Reconstruction without Annuloplasty f. Valvectomy  
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Weight (kg)  
Indicate the weight of the patient in kilograms closest to the date of surgery.  
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FAQ 
 
Which fields can prevent the calculation from taking place? 
 
Risk values are calculated for the following procedures categories only:  
 
CABG Only  
Aortic Valve Replacement (AVRepl) 
Mitral Valve Replacement (MVRepl) 
Mitral Valve Repair (MVRepr) 
AVRepl+CABG 
MVRepl+CABG  
MVRepr+CABG 
 
Note that at the present time there is no model for double valve replacements . 
 
What eligibility criteria must be met in order to calculate risk scores? 
 
Date of Surgery must be greater than 1/1/2000.  
For CABG Only Renal Failure, the Dialysis field must be No.  
 
How should I interpret the results? 

The results of the various risk model calculations need to be interpreted with caution. 
Several reasons for this can be given. 
 
Statistical models should only be used to evaluate situations in conjunction with the 
model's underlying statistical significance. No statistical parameters, other than 
outcome, are presented here. 
 
Even with large databases, certain combinations of risk factors seldom if ever occur 
together. When combined randomly within a given model, curious and misleading 
results might occur that may bear little resemblance to reality. 
 
Models are, at best, only an approximation of the real situation. They are useful for 
examining interrelationships between risk factors and for comparing one type of model 
with another. They should never be used as the sole criteria to make life and death 
decisions concerning the delivery of health care. 

 
What are the minimum operating system requirements to be able to run the risk 
modeler? 
 
Windows 2000K, Windows XP Pro, Windows Vista operating systems.  Microsoft 
Access must be installed. 
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What algorithms are used to calculate the risk values? 
 
The algorithms are primarily the risk algorithms described by the STS detailed in the 
2.61 software specifications. For more information, please contact the San Francisco 
Heart & Vascular Institute. 
 
Is this program HIPPA compliant ? 

Yes.  The patient database is both encrypted and password enabled.  The database 
password is hard-coded in the program so that it is not possible for anyone to access 
the patient database accept through the use of the software. 
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STS National Database and Risk Calculator 
 
The Society of Thoracic Surgeons offers outcome programs in the areas of Adult 
Cardiac, General Thoracic and Congenital surgery. By committing to collecting 
outcomes data to the STS National Database, surgeons are committing to improving the 
quality of care that their cardiothoracic surgery patients receive. 
 
Since 1994, more than 40 publications have come from the STS National Databases. 
These studies have been published in a variety of professional journals and textbooks. 
The STS National Database has recently served as the basis for a federally funded 
national quality improvement randomized trial, as well as research in targeted areas of 
cardiac surgery. 
 
This site contains information for both potential and current participants in any of the 
STS National Databases.  It also contains an online risk calculator at 
http://www.sts.org/sections/stsnationaldatabase/riskcalculator/ 

The STS Risk Calculator allows a user to calculate a patient’s risk of mortality and other 
morbidities, such as long length of stay and renal failure. The Risk Calculator 
incorporates the STS risk models that are designed to serve as statistical tools to 
account for the impact of patient risk factors on operative mortality and morbidity.

http://www.sts.org/
http://www.sts.org/sections/stsnationaldatabase/riskcalculator/
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Benchmarks 

Benchmarks for various procedures outcomes are available.  The Society of Thoracic 
Surgeons collects data from hundreds of hospitals each year and makes the results 
available the average observed results available.  Some of these are shown in the 
following tables. 

 

Table 1.  Results for in hospital mortality and operative mortality for year 2007 

  In Hospital Operative *   95 % C.I. * 

PROCEDURE Mortality % Mortality % N Lower Upper 

Isolated CABG 2.0 2.3 154188 2.22 2.37 

Isolated Aortic Valve 
Replacement  2.5 3.0 17592 2.75 5.52 

Isolated Mitral Valve 
Replacement 5.4 6.0 4251 5.29 1.31 

Aortic Valve Replacement + 
CABG 4.3 4.8 14957 4.46 8.23 

Mitral Valve Replacement + 
CABG 10.0 10.7 2427 9.47 2.23 

Mitral Valve Repair 1.6 1.8 5076 1.43 4.46 

Mitral Valve Repair + CABG 5.5 6.1 4566 5.41 13.0 

* Operative Mortality = death within 30 days of the operation 
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Table 2.  Results for permanent stroke for year 2007 

      95 % C.I. 

PROCEDURE Stroke % N Lower Upper 

Isolated CABG 1.1 154188 1.05 1.15 

Isolated Aortic Valve Replacement  1.4 17592 1.23 1.57 

Isolated Mitral Valve Replacement 2.1 4251 1.67 2.53 

Aortic Valve Replacement + CABG 2.3 14957 2.06 2.54 

Mitral Valve Replacement + CABG 3.4 2427 2.68 4.12 

Mitral Valve Repair 1.3 5076 0.99 1.61 

Mitral Valve Repair + CABG 2.4 4566 1.96 2.84 

 
Table 3.  Results for renal failure for year 2007 

      95 % C.I. 

PROCEDURE 
Renal Failure 

% N Lower Upper 

Isolated CABG 3.5 154188 3.41 3.59 

Isolated Aortic Valve Replacement  4.4 17592 4.10 4.70 

Isolated Mitral Valve Replacement 6.6 4251 4.85 7.35 

Aortic Valve Replacement + CABG 7.5 14957 7.08 7.92 

Mitral Valve Replacement + CABG 12.2 2427 10.90 13.50 

Mitral Valve Repair 2.6 5076 2.16 3.04 

Mitral Valve Repair + CABG 10.3 4566 9.42 11.18 
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Table 4.  Results for prolonged ventilatory support (> 24 hrs) for year 2007 

      95 % C.I. 

PROCEDURE 

Prolonged 
Vent Support 

% N Lower Upper 

Isolated CABG 9.2 154188 9.06 9.34 

Isolated Aortic Valve Replacement  10.2 17592 9.75 10.65 

Isolated Mitral Valve Replacement 19.4 4251 18.21 20.59 

Aortic Valve Replacement + CABG 16.3 14957 15.71 16.89 

Mitral Valve Replacement + CABG 33.1 2427 31.23 34.97 

Mitral Valve Repair 7.7 5076 6.97 8.43 

Mitral Valve Repair + CABG 25.0 4566 2.37 2.63 
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Table 5.  Results for deep sternal wound infection for year 2007 

      95 % C.I. 

PROCEDURE 
Sternal 

Wound % N Lower Upper 

Isolated CABG 0.3 154188 0.27 0.33 

Isolated Aortic Valve Replacement  0.3 17592 0.22 0.38 

Isolated Mitral Valve Replacement 0.4 4251 0.21 0.59 

Aortic Valve Replacement + CABG 0.6 14957 0.48 0.72 

Mitral Valve Replacement + CABG 0.7 2427 0.37 1.03 

Mitral Valve Repair 0.2 5076 0.08 0.32 

Mitral Valve Repair + CABG 0.9 4566 0.63 1.17 

 
Table 6.  Results for reoperation for year 2007 

      95 % C.I. 

PROCEDURE Reop % N Lower Upper 

Isolated CABG 5.0 154188 4.89 5.11 

Isolated Aortic Valve Replacement  8.0 17592 7.60 8.40 

Isolated Mitral Valve Replacement 12.3 4251 11.31 13.29 

Aortic Valve Replacement + CABG 10.0 14957 9.52 10.48 

Mitral Valve Replacement + CABG 15.5 2427 14.06 16.94 

Mitral Valve Repair 6.5 5076 5.82 7.18 

Mitral Valve Repair + CABG 11.3 4566 10.38 12.22 
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Table 7.  Results for any one or more of the above for year 2007 

      95 % C.I. 

PROCEDURE Any % N Lower Upper 

Isolated CABG 14.8 154188 14.62 14.98 

Isolated Aortic Valve Replacement  18.2 17592 17.63 18.77 

Isolated Mitral Valve Replacement 29.3 4251 27.93 30.67 

Aortic Valve Replacement + CABG 25.8 14957 25.10 26.50 

Mitral Valve Replacement + CABG 45.2 2427 43.22 47.18 

Mitral Valve Repair 13.6 5076 12.66 14.54 

Mitral Valve Repair + CABG 34.1 4566 32.72 35.48 

 
Table 8.  Results for prolonged hospital stay (> 14 days) for year 2007 

      95 % C.I. 

PROCEDURE 
Prolonged 

Stay % N Lower Upper 

Isolated CABG 5.6 154188 5.49 5.71 

Isolated Aortic Valve Replacement  8.5 17592 8.09 8.91 

Isolated Mitral Valve Replacement 16.1 4251 15.00 17.20 

Aortic Valve Replacement + CABG 13.2 14957 12.66 13.74 

Mitral Valve Replacement + CABG 24.6 2427 22.89 26.31 

Mitral Valve Repair 6.2 5076 5.54 6.86 

Mitral Valve Repair + CABG 18.7 4566 17.57 19.83 
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Table 9.  Results for short hospital stay (< 6 days) for year 2007 

      95 % C.I. 

PROCEDURE 
Prolonged 

Stay % N Lower Upper 

Isolated CABG 50.0 154188 49.75 50.25 

Isolated Aortic Valve Replacement  37.9 17592 37.18 38.62 

Isolated Mitral Valve Replacement 21.7 4251 20.46 22.94 

Aortic Valve Replacement + CABG 26.0 14957 25.30 26.70 

Mitral Valve Replacement + CABG 15.0 2427 13.58 16.42 

Mitral Valve Repair 48.4 5076 47.03 49.77 

Mitral Valve Repair + CABG 19.5 4566 18.35 20.65 
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Security 
 
In order to insure the secure storage of patient information, all patient information is 
stored in a PliaTech XML™  database that is both encrypted and password enabled.  In 
addition, any patient information stored on hard disk in the application-specific smx files, 
are stored in binary file format that is encrypted using the Advanced Encryption 
Standard with a 256-bit key, making those files more than adequately secure.  You have 
the option to use disk files, to store patient information in the patient database, or both.  
Note that patient information contained in both the disk files and in the application 
patient database can only be accessed through the current application software.  
Obviously, access to the software is critical to the security of the contained patient data.  
Securing your copy of the software on your computer is entirely your responsibility. 

 HIPAA Compliant 

By participation in the use of this software, the user implicitly agrees to comply with all 
statues and regulations, under federal and state laws, concerning patient privacy and 
data security, including but not limited to the privacy regulations promulgated under the 
Health Insurance Portability and Accountability Act of 1996 "HIPAA". 
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Credits 

This application was developed by Michael B. Pliam, MD, PhD, as an independent 
consultant for the San Francisco Heart & Vascular Institute at Seton Medical Center, a 
Daughters Of Charity Hospital. 

The general plan of the 9 risk models and 7 procedural categories follows that devised 
by the Society of Thoracic Surgeons (STS) Risk Calculator.   The risk algorithms used 
to calculate the outcomes risk have been modified by the author in order to correspond 
to data currently available in the SFHI database.  Further, detailed information regarding 
the risk calculations were generously provided by Mr. Nick Gawrit of Heartbase ™. 

The application was compiled using Microsoft Visual Studio 2005. 
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DISCLAIMER 
 
THE SAN FRANCISCO HEART & VASCULAR INSTITUTE, ON ITS OWN BEHALF 
AND ON BEHALF OF ALL OF ITS SERVICE PROVIDERS ASSOCIATED WITH THE 
CARDIAC SURGERY  RISK MODELER (HEREINAFTER COLLECTIVELY 
REFERRED TO AS "SFHI"), DISCLAIMS ANY AND ALL RESPONSIBILITY OR 
LIABILITY FOR THE ACCURACY, CONTENT, COMPLETENESS, LEGALITY, 
RELIABILITY, OPERABILITY, OR AVAILABILITY OF INFORMATION OR MATERIAL 
DISPLAYED IN THE RISK MODELER RESULTS. SFHI DISCLAIMS ANY 
RESPONSIBILITY FOR THE DELETION, FAILURE TO STORE, MISDELIVERY, OR 
UNTIMELY DELIVERY OF ANY INFORMATION OR MATERIAL. SFHI DISCLAIMS 
ANY RESPONSIBILITY FOR ANY HARM RESULTING FROM DOWNLOADING OR 
ACCESSING ANY INFORMATION OR MATERIAL ON THE INTERNET THROUGH 
THE RISK MODELER.  
 
THE RISK MODELER, AND ALL MATERIALS, INFORMATION, PRODUCTS AND 
SERVICES INCLUDED IN THE RISK MODELER ARE PROVIDED "AS IS," WITH NO 
WARRANTIES WHATSOEVER. SFHI AND ITS LICENSORS EXPRESSLY DISCLAIM 
TO THE FULLEST EXTENT PERMITTED BY LAW ALL EXPRESS, IMPLIED, AND 
STATUTORY WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
AND NON-INFRINGEMENT OF PROPRIETARY RIGHTS. SFHI AND ITS LICENSORS 
DISCLAIM ANY WARRANTIES REGARDING THE SECURITY, RELIABILITY, 
TIMELINESS, AND PERFORMANCE OF THE RISK MODELER. SFHI AND ITS 
LICENSORS DISCLAIM, ANY WARRANTIES FOR ANY INFORMATION OR ADVICE 
OBTAINED THROUGH THE RISK MODELER.  
 
YOU UNDERSTAND AND AGREE THAT YOU DOWNLOAD OR OTHERWISE 
OBTAIN MATERIAL OR DATA THROUGH THE USE OF THE RISK MODELER AT 
YOUR OWN DISCRETION AND RISK AND THAT YOU WILL BE SOLELY 
RESPONSIBLE FOR ANY DAMAGES TO YOUR COMPUTER SYSTEM OR LOSS OF 
DATA THAT RESULTS FROM THE DOWNLOAD OF SUCH MATERIAL OR DATA.  
 
SOME STATES OR OTHER JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSIONS MAY NOT APPLY TO YOU. 
YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE AND 
JURISDICTION TO JURISDICTION.  
 
Disclaimer of Liability 
 
SFHI IS PROVIDING INFORMATION AND SERVICES AS A BENEFIT AND SERVICE 
IN FURTHERANCE OF ITS NONPROFIT, EDUCATIONAL MISSION. THE USER 
ASSUMES ALL RESPONSIBILITY FOR, AND HOLDS SFHI HARMLESS FROM ANY 
CLAIMS ARISING OUT OF, ITS USE OR MISUSE OF, OR INABILITY TO USE, THE 
RISK MODELER, WHETHER SUCH CLAIM IS BASED ON WARRANTY, CONTRACT, 
OR TORT (INCLUDING NEGLIGENCE). UNDER NO CIRCUMSTANCES, INCLUDING 
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BUT NOT LIMITED TO NEGLIGENCE, SHALL SFHI OR ANYONE ELSE INVOLVED 
IN CREATING OR MAINTAINING THE RISK CALCULATOR BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, EXEMPLARY, OR 
PUNITIVE DAMAGES, OR LOST PROFITS THAT RESULT FROM THE USE OR 
MISUSE OF, OR INABILITY TO USE, THE RISK MODELER, INCLUDING, BUT NOT 
LIMITED TO, RELIANCE BY A USER ON ANY INFORMATION OBTAINED VIA THE 
RISK MODELER, OR THAT RESULT FROM MISTAKES, OMISSIONS, 
INTERRUPTIONS, DELETION OF FILES, VIRUSES, ERRORS, DEFECTS, OR ANY 
FAILURE OF PERFORMANCE, COMMUNICATIONS FAILURE, THEFT, 
DESTRUCTION OR UNAUTHORIZED ACCESS WITH RESPECT TO THE RISK 
MODELER (INCLUDING SUCH DAMAGES INCURRED BY THIRD PARTIES). SFHI IS 
NOT RESPONSIBLE FOR ANY TREATMENT OR OTHER MEDICAL DECISIONS 
MADE BY USERS BASED ON INFORMATION OBTAINED VIA THE RISK MODELER, 
AND USER AGREES TO INDEMNIFY SFHI AND HOLD SFHI HARMLESS FROM ANY 
CLAIMS ARISING OUT OF SUCH DECISIONS.  
 
WITHOUT LIMITING THE FOREGOING, UNDER NO CIRCUMSTANCES SHALL SFHI 
OR ITS LICENSORS BE HELD LIABLE FOR ANY DELAY OR FAILURE IN 
PERFORMANCE RESULTING DIRECTLY OR INDIRECTLY FROM ACTS OF 
NATURE, FORCES, OR CAUSES BEYOND ITS REASONABLE CONTROL, 
INCLUDING, WITHOUT LIMITATION, INTERNET FAILURES, COMPUTER 
EQUIPMENT FAILURES, TELECOMMUNICATION EQUIPMENT FAILURES, OTHER 
EQUIPMENT FAILURES, ELECTRICAL POWER FAILURES, STRIKES, LABOR 
DISPUTES, RIOTS, INSURRECTIONS, CIVIL DISTURBANCES, SHORTAGES OF 
LABOR OR MATERIALS, FIRES, FLOODS, STORMS, EXPLOSIONS, ACTS OF GOD, 
WAR, GOVERNMENTAL ACTIONS, ORDERS OF DOMESTIC OR FOREIGN 
COURTS OR TRIBUNALS, NON-PERFORMANCE OF THIRD PARTIES, OR LOSS 
OF OR FLUCTUATIONS IN HEAT, LIGHT, OR AIR CONDITIONING.  
 
IN STATES WHICH DO NOT ALLOW SOME OR ALL OF THE ABOVE LIMITATIONS 
OF LIABILITY, LIABILITY SHALL BE LIMITED TO THE GREATEST EXTENT 
ALLOWED BY LAW. 
 
Patient Privacy 
 
The Risk Modeler does collect personally identifiable patient information such as name, 
age, medical record number, and individually identifiable health information.  This 
information is necessary in order to operate the Risk Modeler.  It is the sole 
responsibility of the user to safeguard the privacy and security of this patient information 
in keeping with HIPPA and other Federal and Local patient privacy regulations.  SFHI 
disclaims any responsibility for the use or misuse of patient information collected and/or 
stored in the Risk Modeler software or its associated databases. 

 
General. 
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These Terms and Conditions constitute the entire agreement between the parties with 
respect to the Risk Modeler and supersede and replace all prior or contemporaneous 
understandings or agreements, written or oral, regarding such subject matter. Any 
waiver of any provision of the Terms and Conditions will be effective only if in writing 
and signed by an authorized representative of SFHI. These Terms and Conditions shall 
be governed and interpreted in accordance with the laws of the State of California, 
applicable to contracts made and fully performed therein. If any provision of these 
Terms and Conditions is held by a court of competent jurisdiction to be contrary to law, 
that provision will be enforced to the maximum extent permissible and the remaining 
provisions will remain in full force and effect. SFHI may modify these Terms and 
Conditions without notice. 
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License Agreement 

You should carefully read the following terms and conditions before using this software. 
Unless you have a different license agreement signed by PliaTech Software,  your use 
of this software indicates your acceptance of this license agreement and warranty. 

Registered Version 

One registered copy of Cardiac Surgery Risk Modeler ™  may either be used by a 
single person who uses the software personally on one or more computers, or installed 
on a single workstation used non-simultaneously by multiple people, but not both. 

You may access the registered version of Cardiac Surgery Risk Modeler ™  through a 
network, provided that you have obtained individual licenses for the software covering 
all workstations that will access the software through the network. For instance, if 8 
different workstations will access Cardiac Surgery Risk Modeler ™  on the network, 
each workstation must have its own Cardiac Surgery Risk Modeler ™  license, 
regardless of whether they use Cardiac Surgery Risk Modeler ™  at different times or 
concurrently. 

csurgpts.mdb, coefs2007.mdb, smx files, and  modules, included with Cardiac Surgery 
Risk Modeler ™ , may be used at workstations licensed to use the registered version of 
Cardiac Surgery Risk Modeler ™  to create an unlimited number of freely distributable 
royalty-free smx files.  Smx  files created by Cardiac Surgery Risk Modeler ™  are 
copyrighted software covered by the proprietary notices, and identifying information (the 
"Risk Modeler Software"). No registered user may alter or modify the Risk Modeler 
Software. You cannot give anyone else permission to modify the Risk Modeler 
Software. 

Governing Law 

This agreement shall be governed by the laws of the State of California. 

Disclaimer of Warranty 

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND 
WITHOUT WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY 
OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. In particular, there is no 
warranty for any damages that might be incurred by any user as a result of inaccuracy of a 
calculation or for incomplete or misinformation provided by the Cardiac Surgery Risk Modeler 
™  help file. Because of the various hardware and software environments into which 
Cardiac Surgery Risk Modeler ™ may be put, NO WARRANTY OF FITNESS FOR A 
PARTICULAR PURPOSE IS OFFERED. 

Good data processing procedure dictates that any program be thoroughly tested with 
non-critical data before relying on it. The user must assume the entire risk of using the 
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program. ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO 
PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE. 

  

 

 


